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Preface

Introduction

This section contains general information that will be useful to know before
using the MCP250XX Development Kit.

Highlights

This section covers the following topics:
» About this Guide
* Recommended Reading
» Warranty Registration

Troubleshooting
» The Microchip Internet Web Site
» Customer Support

About This Guide

DOCUMENT LAYOUT

This document describes how to use the MCP250XX Development Kit to
evaluate CAN 1/O Expander applications using MCP250XX devices.

The User’s Guide layout is as follows:

« Chapter 1: Product Overview and Installation — details the hardware
and software components and discusses installation procedures.

* Chapter 2: MCP250XX Tutorial — covers some of the key elements of
the MCP250XX by going through the steps for setting up and running
the demonstration program.

* Chapter 3: Programming the MCP250XX Using the Development
Board - describes the procedure for programming the MCP250XX
using the programming circuitry and special software.

» Chapter 4: Other Capabilities of the MCP250XX Development Kit -
details the other capabilities of the MCP250XX Development Kit,
including configuring the board for multiple oscillators, connecting the
board to the MCP2510 development board, and connecting the board
to external CAN busses.

© 2002 Microchip Technology Inc. DS51266B-page v
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Updates

Appendices

« Appendix A: Schematics and Layouts — lists the schematics and
layouts diagrams for the MCP250XX Development Kit.

* Index — cross-reference listing of terms, features and sections of this
document.

» Worldwide Sales and Service — provides the address, telephone and
fax numbers for Microchip Technology Inc. sales and service locations
throughout the world.

Since Microchip tools are constantly evolving to meet customer needs, some
software dialogs and/or tool descriptions may differ from this document.
Please refer to the Microchip web site to obtain the latest documentation
available.

Warranty Registration

Please complete the enclosed Warranty Registration Card and mail it
promptly. Sending in the Warranty Registration Card entitles you to receive
new product updates. Interim software releases are available at the Microchip
web site.

Recommended Reading

This user’s guide describes how to use the MCP250XX Development Kit. For
more information regarding the MCP250XX devices and other CAN related
topics, the following are recommended reading.

MCP2502X/2505X Data Sheet (DS21664)

This data sheet provides detailed information regarding the MCP250XX
CAN I/O Expanders.

MCP2510 Data Sheet (DS21291)

This data sheet provides detailed information regarding the MCP2510
Stand-Alone CAN Controller, which is the master node on the board.

ProMate® Il User’s Guide (DS30082)

This manual contains a section explaining how to program the MCP250XX
devices using the specified socket module

MCP250XX Programming Specification (DS20072)

This specification explains the requirements for programming the
MCP250XX using the ICSP™ protocol.

ANB815 - Understanding the MCP250XX Devices (DS00815)

AN816 - A CAN System Using Multiple MCP250XX I/O Expanders
(DS00816)

DS51266B-page Vi
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AN713 - An Introduction to the CAN Protocol Application Note
(DS00713)

This application note will help those new to the CAN protocol, come up to
speed on CAN quickly.

AN754 - Understanding Microchip’s CAN Module Bit Timing Application
Note (DS00754)

This application note is an in-depth discussion of bit timing using
Microchip’s CAN module.

A CAN Kingdom by Lars-Berno Fredriksson (Kvaser AB)

This document covers the CAN Kingdom Specification and should help
give an insight into the main software and some of the menu items that
refer to CAN Kingdom specific functions. More information can be found
at www.cankingdom.org

CANKing Help Files

The help files are a good resource for answering the common questions
about the MCP250XX Development Kit, including the CAN Kingdom
specific menu items.

README Files
Contain the latest information on the MCP250XX Evaluation System.
Technical Library CD-ROM (DS00161)

This CD-ROM contains comprehensive application notes, data sheets,
and technical briefs for all Microchip products. To obtain this CD-ROM,
contact the nearest Microchip Sales and Service location (see back page).

Microchip Web Site

Our web site (http://www.microchip.com) contains a wealth of documenta-
tion. Individual data sheets, application notes, tutorials and user’s guides
are all available for easy download. All documentation is in Adobe Acrobat
(pdf) format.

Microsoft® Windows® Manuals

These manuals assume that users are familiar with the Microsoft Windows
operating system. Many excellent references exist for this software
program and should be consulted for general operation of Windows.

Troubleshooting

See the README files for information on common problems not addressed in
this user’s guide.

© 2002 Microchip Technology Inc.
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The Microchip Internet Web Site

Microchip provides on-line support on the Microchip World Wide Web (WWW)
site.

The web site is used by Microchip as a means to make files and information
easily available to customers. To view the site, the user must have access to
the internet and a web browser, such as Netscape® Communicator or
Microsoft® Internet Explorer®. Files are also available for FTP download from
our FTP site.

Connecting to the Microchip Internet Web Site

The Microchip web site is available by using your favorite Internet browser
to attach to:

http://www.microchip.com
The file transfer site is available by using an FTP program/client to connect to:
ftp://ftp.microchip.com

The web site and file transfer site provide a variety of services. Users may
download files for the latest Development Tools, Data Sheets, Application
Notes, User's Guides, Articles, and Sample Programs. A variety of Microchip
specific business information is also available, including listings of Microchip
sales offices, distributors and factory representatives. Other data available for
consideration is:

» Latest Microchip Press Releases

+ Technical Support Section with Frequently Asked Questions
» Design Tips

» Device Errata

» Job Postings

* Microchip Consultant Program Member Listing

 Links to other useful web sites related to Microchip Products

» Conferences for products, Development Systems, technical information
and more

« Listing of seminars and events

DS51266B-page viii © 2002 Microchip Technology Inc.
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Customer Support

Users of Microchip products can receive assistance through several
channels:

 Distributor or Representative

* Local Sales Office

+ Field Application Engineer (FAE)

+ Corporate Applications Engineer (CAE)
* Hot line

Customers should call their distributor, representative or field application
engineer (FAE) for support. Local sales offices are also available to help
customers. See the back cover for a listing of sales offices and locations.

Corporate applications engineers (CAEs) may be contacted at
(480) 792-7627.

In addition, there is a Systems Information and Upgrade Line. This line
provides system users a listing of the latest versions of all of Microchip's
development systems software products. Plus, this line provides information
on how customers can receive any currently available upgrade kits.

The Hot Line numbers are:

1-800-755-2345 for U.S. and most of Canada, and
1-480-792-7302 for the rest of the world.

© 2002 Microchip Technology Inc. DS51266B-page ix
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Chapter 1. Product Overview and Installation

1.1 Introduction

This chapter provides an overview of the MCP250XX Development Kit,
instructions on how to connect the system components and how to install the
software.

1.2 Highlights

This chapter covers the following topics:

* What is the MCP250XX Development Kit?

+ System Requirements
MCP250XX Development Kit Components
MCP250XX Development Board Components

« Hardware Installation

« Software Installation

1.3 What is the MCP250XX Development Kit?

The MCP250XX Development Kit is an evaluation, demonstration and
development tool for Microchip Technology’s 14-pin CAN 1/O Expanders. The
MCP250XX can be evaluated easily by installing the provided software and
running the demonstration program. Furthermore, development can be done
by utilizing the bare CAN node with prototyping area, along with the on-board
device programmer.

The development board has the ability of programming the user defined
defaults by using the device programmer module and the supplied software.
Alternatively, the In-Circuit Serial Programming™ (ICSP™!) protocol can be
used to program the MCP250XX using the 5-pin header, which is connected
to a 14-pin socket on the board. See the MCP250XX Programming
Specification (DS20072) for details on programming via ICSP.

Some of the key features of the MCP250XX Development Kit:
+ Evaluation of Microchip’s CAN I/O Expanders
* Programming the MCP2505X devices using supplied software
* Programming the MCP2505X devices via the ICSP protocol
» Connectable to external CAN networks

© 2002 Microchip Technology Inc. Preliminary DS51266B-page 1
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1.4 System Requirements

To take full advantage of the MCP250XX features, you must install the
supplied demonstration/evaluation software on a host computer. The
MCP250XX requires:

« Microsoft® Windows® 95/98/ME/NT/2000 operating system
* One free parallel port
+ CD-ROM drive

DS51266B-page 2 Preliminary © 2002 Microchip Technology Inc.
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1.5 MCP250XX Development Kit Components

The MCP250XX Development Kit contains:
*+ MCP250XX Development Board
* MCP250XX Development Kit User’s Guide

+ MCP250XX Development Kit CD-ROM with demo and programming
software

» Parallel port cable

* 9V DC power supply adapter

« Warranty/Registration card

» Three MCP25020 CAN I/O Expanders
» Three MCP25050 CAN I/O Expanders

FIGURE 1.1: MCP250XX DEVELOPMENT KIT

© 2002 Microchip Technology Inc. Preliminary DS51266B-page 3
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1.6 MCP250XX Development Board Components

The MCP250XX Development Board consists of four main parts (see

Figure 1.4):

1. PC Node

2. Node A

3. NodeB

4. Device Programmer

1.6.1 PC Node

The PC Node is the master node for the demonstration program that controls
Node B. This node contains a MCP2510 Stand-Alone CAN Controller that is
controlled by the host PC via a custom parallel port interface.

Note: All three nodes are connected to a common CAN bus that has
external connections via the DB9 connector.

1.6.2 Node A

Node A is a bare CAN node next to the prototyping area. This node is used for
MCP250XX prototyping and can also be used to program the user defaults
via the ICSP protocol. See Figure 1.2 for pinout description

FIGURE 1.2: NODE A PINOUT

ICSP Header
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2 13[7] X |vss
3 12[7] X | DATA
a 10 —X] | cLOCK
—1 |5 10 ]
6 9]
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1.6.3

Node B

Node B is the slave node for the demonstration program. Analog inputs
(potentiometers), PWM outputs (piezo buzzer and incandescent lamp) and
digital inputs (push-buttons) are all connected to the MCP25050 device. It
responds to inputs and CAN messages accordingly to demonstrate device
functionality. See Figure 1.3 for pinout description.

FIGURE 1.3: NODE B PINOUT

MCP250XX
LP1 GPO[1 - 14| ] vop
R20 2 13]] st
GP2— , 1207
4 1
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1.6.4

1.6.5

Device Programmer

The Device Programmer module is used with PC software to configure the
user-defined defaults.

FIGURE 1.4: MCP250XX DEVELOPMENT BOARD
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Key Areas of the MCP250XX Development Board

There are a few key areas on the board. Figure 1.4 shows these areas and
Table 1.1 details them.

Table 1.1: MCP250XX Board Layout

Key Areas Description
DB25 The DB25 is the connection to the host PC interface. The PC controls
both the PC Node and the Device Programmer circuit.
ué The CAN Controller (MCP2510) of the PC Node that is controlled by

the host PC.

u15, J5, and JP4

U15 is the prototyping node. J5 is the ICSP header for U15. JP4 jump-
ers board power to the VDD pin of U15 and should be removed if using
J5 (ICSP header) to isolate U15 from the rest of the board during
In-Circuit Serial Programming.

u14 The MCP250XX for the demonstration program. Connected to the
potentiometers, piezo, buttons and lamp.
u3 The socket for programming the user-defined defaults using the

programming software.

Y1,Y2,Y3, JP1, and
JP2

Y1, Y2 and Y3 are the oscillator sockets for each of the three CAN
nodes. By default, all of the Yx outputs are connected together (JP1
and JP2 are shorted via a trace on the back of the board) and only Y1
is populated (i.e., Y1 clocks all three CAN nodes). To separate the
oscillator sockets, the traces shorting JP1 and JP2 must be cut.

U111, U12, U13, J3,
and J4

U11 - U13 are the CAN drivers all connected to a common CAN bus.
The two DB9s (J3 and J4) are the external CAN bus connections. Only
J4 is populated.

D2, D3, D4, and D5

CAN ftraffic indicator LEDs. D2 represents all traffic. D3 - D5 represent
transmitted traffic of each of the three nodes.

DS51266B-page 6
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1.7

1.7.1

1.7.2

1.7.3

Hardware Installation

This section describes the hardware connections.

Connecting the DB25 Cable

The included DB25 cable is a male-to-male configuration and plugs into the
parallel port of the host PC. Figure 1.5 shows the pin configuration.

FIGURE 1.5: DB25 PIN CONFIGURATION
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9V Power Supply Adapter
The power supply is rated at 9V, 750 mA DC.

DB9 External CAN Bus Connectors (optional)

The DB9 connector, as shown in Figure 1.6, is used to connect the
MCP250XX Development Board to an external CAN bus and is not necessary
for basic board operation.

Note: Only the DB9 at J4 is populated. J3 is available as needed. I

FIGURE 1.6: DB9 CAN CONNECTOR

© 2002 Microchip Technology Inc.
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1.8 Software Installation

Insert the MCP250XX Development Kit CD-ROM into the CD-ROM drive.

1.8.1 Autorun Enabled

If autorun is enabled, the installation program will automatically start. Follow
the instructions on the screen to install the software.

1.8.2 Autorun Not Enabled

If autorun is not enabled:

1. Click the Start button and select Run. Enter d: \setup.exe
(where 4:\ is your CD-ROM drive). Click OK. Or alternatively, find the
CDROM drive using “Windows Explorer” and double click “setup.exe”.

Note: Windows NT® and Windows 2000 users must have administrative
privileges in order to install the MXLAB® software.

2. Follow the on-line instructions to install the software.

DS51266B-page 8 Preliminary © 2002 Microchip Technology Inc.
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Chapter 2. MCP250XX Basic View Tutorial

2.1 Introduction

The MCP250XX Development Kit provides the means for programming and
evaluating the MCP250XX CAN /O Expander devices. This tutorial discusses
the evaluation portion of the kit. This chapter details the demonstration
software (Basic Template) and CAN system (PC Node and Node B), as well
as covering the steps required to successfully run the demonstration network.

The user defaults for Node B are pre-programmed at the factory. Therefore,
no user default programming is necessary. No discussion of programming will
take place in this chapter. The following chapter will detail programming user
defaults.

Note: The software must be installed, and the hardware connected, to
run the demonstration program.

2.2 Highlights

This chapter covers the following topics:
+ Setting up the Evaluation Mode
+ Establishing Communications
+ Explaining the CAN Messages

2.3 Setting up the Basic Template Evaluation Mode

The MCP250XX Development Kit “Basic Template” contains the following
major elements:

1. Menu Bar (Figure 2.1) - The layout is typical of most Windows menu
bars.

2. PC Node Bit Timing and Mode (Figure 2.2) - The bit timing and the
mode of operation (Normal and Configuration) for the MCP2510 (PC
Node) are configured with this window.

3. Board Status (Figure 2.3) - Indicates if the board is connected to the PC
and also indicates the parallel port address used.

4. Message Format Window (Figure 2.4) - Selects how CAN messages
are formatted and interpreted. The default is “Standard Text Format” and
is used for the demonstration program. The other format is used with the
CAN Kingdom higher layer protocol.

5. Bus Monitor Window (Figure 2.5) - Also known as the Output window.
This window shows all bus traffic.

© 2002 Microchip Technology Inc. Preliminary DS51266B-page 9



MCP250XX USER’S GUIDE

6. MCP250XX Demonstration (Figure 2.6) - This window is the graphical
interpretation of the Node B (the demonstration node).

FIGURE 2.1: MENU BAR

CAMKing for Windows - [eval_slio.wct] (- [O] =]
File View Messages Option: Window Help
D= b

FIGURE 2.2: PC NODE BIT TIMING AND MODE
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FIGURE 2.3: BOARD STATUS
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FIGURE 2.4: MESSAGE FORMAT WINDOW
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FIGURE 2.5: BUS MONITOR WINDOW
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FIGURE 2.6: MCP250XX DEMONSTRATION WINDOW
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2.3.1 Starting the Program

1. Start the software by any of the following:
+ From the “Start” menu, select “Programs > Microchip > CANKing*“
* Or select “C:\Program Files\Microchip\Mcan\WC32.exe”
* Or Double click on the desktop icon for the MCP250XX Development

Kit

2. A notice will appear warning of the potential undesired results if connect-
ing to an existing CAN bus (Figure 2.7). Select “OK, | know what | am
doing”.

3. Next, a dialog will appear asking if a new template or a saved project
should be opened. Select “New Template” (Figure 2.9).

4. When the template dialog appears, select “MCP250XX Evaluation”
(Figure 2.10).

The software is now started. There are a few other options that the user may
want to configure for convenience before saving the project and capturing the
defaults.

2.3.2 Setting the Numeric Base for Transmit and Monitor
Windows

The default numeric base can be changed as desired for both the transmit
buffer window and the bus monitor window. Base 16 (hex) numbers are
preceded by a “$”.

2.3.2.1 Transmit Buffer Window

The numeric base for the transmit buffer is configured by selecting “Options >
Global...” from the menu. Check desired numeric base.

2.3.2.2 Bus Monitor Window

If the “Select Formatters” window is not visible, select it from the “View” menu.
Highlight (do not uncheck) the “Standard Text Format” text in the “Select
Formatters® window. Click “Properties” and check the desired numeric base.
(See Figure 2.8).

A few other items must be addressed before proper communication can
occur, as discussed in the next section.

© 2002 Microchip Technology Inc. Preliminary DS51266B-page 13
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FIGURE 2.7: WARNING ON STARTUP
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FIGURE 2.8: CHANGING NUMERIC BASE FOR BUS MONITOR
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FIGURE 2.9: OPEN DIALOG
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FIGURE 2.10: TEMPLATE DIALOG
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2.4 Establishing Communications

When the software is started from a new template (as it must be the first time
it is started), some steps must be taken to insure proper operation and to set
up the software defaults. These defaults can be saved by saving the template
as a project and opening the project in subsequent sessions.

241 Configure Parallel Port

The board status (including parallel port address and connection status) is
indicated in the Board Status Window (Figure 2.3). Assuming the port
address, as displayed in the window, matches the address as configured by
the PC, the board status should indicate “connected”, with the indicator in the
window being green.

If the status indicator is red and indicates “not connected”, check the port
address. To change the port address that the software uses, select “Options >
MCP2510“ and enter the correct port address in the appropriate dialog box
(Figure 2.11).

Note: Port address is entered as a HEX value. I

FIGURE 2.11: PC NODE OPTIONS

MCP2510 Eval Board Options |
~Hardware Settings

Clock Erequency: IIE-EIIZIIII kHz
Parallel Port &ddress: |$3?=3

~Opkions For the Current Configuration

¥ Reset MCPZ510 on Open

\/ Ok Zancel

24.2 Match Oscillator Frequency with Board

The CAN data rate is a function of the oscillator frequency. Therefore, the
proper oscillator frequency must be set in order for the software to calculate
the CAN data rate correctly. Open the same window that was opened to set
the parallel port address (Figure 2.11). The frequency of oscillation units are
in kilohertz.
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243 Configuring the Output Window Display Format

The output (bus monitor) window (Figure 2.5) can display the CAN messages
in five different ways:

1. Fixed Positions - Messages with the same identifier maintain a fixed
position (slot) within the window. The data and time stamp update nor-
mally. To turn fixed positions on/off, right click the mouse while the cur-
sor is over the output window area and select “Fixed Positions”.

2. Dynamic Positions (Fixed Positions = off) - Each new message is dis-
played below the previous message, regardless of the identifier. This
mode is activated by unchecking Fixed Positions (right mouse click).

3. Auto-Scroll - Keeps the output window from auto-scrolling to the most
recent message (bottom message). This is useful when messages are
being regularly received and the user would like to observe old mes-
sages at the top of the buffer without having the focus shift to the end of
the buffer each time a message is received.

To activate, right click the mouse while the cursor is over the output
window and select “Auto-Scroll”.

4. Delta Time - This is a time stamp that indicates the time(s) between two
messages with the same identifier. Delta Times is activated as follows
(Figure 2.8): If the “Select Formatters” window is not visible, select it
from the “View” menu. Highlight (do not uncheck) the “Standard Text For-
mat” text in the “Select Formatters” window. Click “Properties” and check
the “Delta Times” box.

5. Free Running Time - A free running time stamp between messages
with the same identifiers. This mode is activated by unchecking the
“Delta Times” box.
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2.5 Explaining the CAN Messages

At this point, the two nodes (PC Node and Node B) should be communicating
normally. A message should be showing up in the output window (Figure 2.5)
at regular intervals. Pushing GP4, GP5 or GP6 causes other messages to
show up in the output window, with the status being reflected graphically in
the demo window. Turning the potentiometers will cause the data fields to

change.

This section explains the CAN messages as seen in the output (bus monitor)

window.

Table 2.1: CAN Messages Explained

Identifier | Length Data Explanation
0x008 3 “Write Register” Input DBO (address) is either 0x23 or
Message (IM) 0x26 (PR1 or PWM2DCH).

0x018 8 Read A/D Regs “Read A/D Regs*“ IRM followed
by OM.

0x280 0 None On-bus message.

0x290 8 Read A/D Regs A/D Threshold Detection (R20,
POT and PWM2 duty cycle).

Ox7FF 0 None Command acknowledge in

response to IM.
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Chapter 3. MCP250XX Register View Tutorial

3.1 Introduction

A few topics covered in this chapter were also covered in the last chapter
detailing the Basic Template tutorial. To avoid duplication, the appropriate
sections in Chapter 2 will be referenced.

The MCP250XX Development Kit provides the means for programming and
evaluating the MCP250XX CAN I/O Expander devices. This tutorial discusses
the evaluation portion of the kit. This chapters details the demonstration
software (Register Template) and CAN system (PC Node and Node B). It also
covers the steps required to successfully communicate with the MCP250XX
while in the register template.

The user defaults for Node B are pre-programmed at the factory. Therefore,
no user default programming is necessary. No discussion of programming will
take place in this chapter. The following chapter will detail programming user
defaults.

Note: The software must be installed and the hardware connected to run
the demonstration program.

3.2 Highlights

This chapter covers the following topics:
+ Setting up the Evaluation Mode
+ Establishing Communications
» Explaining the Windows

3.3 Setting up the Register Template Evaluation
Mode

The MCP250XX Development Kit “Register Template” contains the following
major elements that will be discussed in detail later in this chapter:

1. The Menu Bar, PC Node Bit TIming and Mode and Board Status
windows are all discussed in Section 2.3.

2. MCP250XX Filters - Used to setup and test the MCP250XX Mask and
Filters.

3. MCP250XX Error Status - Used to read the current transmit and receive
error counters (TEC and REC), as well as the EFLG register.

4. MCP250XX Physical Layer - Displays the bit timing registers (CNF1,
CNF2 and CNF3).
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5. MCP250XX Command Messages - Implements the Command Mes-
sages as described in the data sheet. Information Request Messages
(IRM), Output Messages and Input Messages are all represented in this
window to enable the main functionality of the MCP250XX.

FIGURE 3.1: MCP250XX FILTERS

MCP25050 Filters P |

—Filkers Mode & ~Filters Node B

Test Identifier: I$E Test Identifier: I$F

o Test Buf |
R#M |$E R#M |$E
RXFO |$6 (9] RLXFO |$D i
R¥F1 |$F i3 FLxF1 |$E (]

Accepted Accepted

ﬁn Read | ; Wrike

ﬁn Read | ; Wirite

FIGURE 3.2: MCP250XX ERROR STATES

MCP25050 Status [— =]
rMode A rMode B
Register ¥alue Meaning Register Yalue Meaning
Tx Ertar $00 (0} Tx Errar 400 (0}
Fex Error $00 (0} Rz Error 400 (0}
EFLG $00 {0} EFLG $00 {0}

,2\ Read |
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FIGURE 3.3: MCP250XX PHYSICAL LAYER

MCP25050 Physical Layer [_ ] =]

rTode A rTode B
Prescaler: IE ill Prop.Seq: Il ﬂ Prescaler: IE ﬁ Prop.Seq: |1 ill
sw: i j Phase Seg 1 3 :ll swi i j Phase Seg 1 |3 :ll

Samples: Il ﬁ Fhase Seqz |3 ﬂ Sarples: Il ﬁ Phase Seqz |3 ill

CMF1 07 o000 o011 CHF1 07 o000 o011
(CMF2 an 1 ojo 1 0000 (CMF2 an 1 ojo 1 0000
CHFS 0z - |0 -|(01 0 CHFS 0z - |0 - -0/10
Bit rate: 125,000 kbitfs {xtal 16.0 MHz) Bit rate: 125,000 kbitfs (<tal 16,0 MHz)

,ﬁn Read |
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FIGURE 3.4: MCP250XX COMMAND MESSAGES

~hode &
~Information Request: Register contents

% Reguest message = Input message

MCP25050 Configuration M= |

~Mode B

 Information Request: Register contents

¥ Request message

= Input message

|_ Uze extended messages |7 = ETHE |_ Uze extended messages p =B
ILIser Mern {bank 2} j ITX Message ID0 j IA,I'D Regs j ITK Message ID0 j
IJSERIDS a3 1 o001 000 IOIMTFLG on ooo0oo0o0o oo
LISERIDS 99 1 oo 1 1/0 0|1 GPIO 35 oo/l 11000
LISERIDLO A 1 ' 0o/1 0o 1/0 1|0 AMOH B4 1 0/1 1 01 00
LSERIDLL EE 101 110 1|1 AM1H 20 oo/l o011 001
LSERIDLZ s 1 1/00 11 0|0 AM1OL 03 o o/o0 o0 1000
IJSERID1S 5] 110011 1/01 ArZH 11 ooolt oo ot
LISERID14 EE 111 011 110 AMSH F3 11/1 1 00 11
LISERIDLS FF 171/1 1711 1]1 AMZ3L 22 oo/l o000 10
| EitS: User Memory Bank | Bit3: Actual bit value

ﬁn Read | é}@ Write .ﬁn Read | ;% Wribe |

—Single byte reqister Read\'rite

IIOINTEN (10

=

—Single byte reqister Read)\rite

IIOINTEN

an

; w'rike

|
ﬁr- Read |

00 olooolola |

($1C)

=

o0 oo oo oo

;- Wrike |

3.31

Starting the Program

Because the start procedures are the same as in Section 2.3.1, there are
references to figures in Chapter 2 in this section.

1. Start the software by any of the following:

+ From the “Start” menu, select “Programs > Microchip > CANKing*“

* Or select “C:\Program Files\Microchip\Mcan\WC32.exe”
* Or Double click on the desktop icon for the MCP250XX Development

Kit

A notice will appear warning of the potential undesired results, if con-

necting to an existing CAN bus (Figure 2.7). Select “OK, | know what |

am doing”.
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3.3.2

3. Next, a dialog will appear asking if a new template or a saved project
should be opened. Select “New Template” (Figure 2.9).

4. When the template dialog appears, select “MCP250XX Evaluation”
(Figure 2.10).

Setting the Numeric Base for Bus Monitor Window

If the “Select Formatters” window is not visible, select it from the “View” menu.
Highlight (do not uncheck) the “Standard Text Format” text in the “Select
Formatters® window. Click “Properties” and check the desired numeric base
(see Figure 2.8).

A few other items must be addressed before proper communication can
occur, as discussed in the next section.

3.4 Establishing Communication

Because the method for establishing communications is exactly the same as
the last chapter, please refer to Section 2.4.

3.5 Explaining the Register Template Windows

3.51

3.5.2

The Register Template provides access to all of the user registers by using
the Command Messages as defined in the data sheet.

General Information

Some general information about the windows.

There are three different ways to enter values into the windows, depending on
the window function:

1. Entering byte value in the appropriate box.
2. Clicking up/down counters to increase/decrease the value by one.

3. Double clicking the desired bit location to toggle the bit to its opposite
state.

The register bit names will be displayed for the location directly under the
mouse pointer (Physical Layer and Configuration windows only).

MCP250XX Filters Window

The MCP250XX Filters window allows the user to read, modify and test the
mask and filters settings. Care must be taken when modifying the mask and
filter settings. Otherwise all or partial communications with the MCP250XX
may be lost due to improper filter and mask settings.

Mask and filter settings can be tested against various identifiers simply by
entering the desired identifier in the “Test Identifier” window and pressing the
“Test Buf” button. This tests the entered identifier with the entered mask and
filters settings and indicates pass/fail for each filter.

© 2002 Microchip Technology Inc.
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Example 3.1: Figure 3.1 shows a test where the mask is configured to
accept IDs of Eh and Fh only (bit0 = 0 = “don’t care”).

3.5.3 MCP250XX Error States

The current receive and transmit error counters (REC and TEC) can be read,
as can the EFLG register. The is the same as the “Read CAN Error”
Information Request Message (IRM).

3.5.4 MCP250XX Physical Layer

The bit timing (CNF registers) cannot be changed from the default values.
However, these registers can be read and displayed along with the parsed
prescaler and TQ settings.

3.5.5 MCP250XX Command Messages

This window implements the Command Messages as described in the data
sheet. Both IRMs and Input messages can be implemented by selecting the
appropriate radio button (see Figure 3.4).

This window also gives the added functionality of reading and/or writing
individual registers. Reading individual registers is actually an IRM that
contains the desired register (e.g. reading IOINTEN register is actually a
“Read Control Register” IRM command with the resulting Output message).
Writing an individual register is a “Write Register” Input command.
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Chapter 4. Programming the MCP250XX User Defaults

4.1 Introduction

The user memory for MCP250XX devices are initially blank from the factory.
The user must program the user memory with user-defined defaults. There
are three methods for programming the user memory.

1. Using MPLAB® IDE with the PRO MATE® I device programmer and the
MCP250XX socket module.

2. Using the Device Programmer circuit on the MCP250XX Development
Board with the programming software.

3. In-Circuit Serial Programming™ (ICSP™), while following the
MCP250XX Programming Specification (DS20072).

4.2 Highlights

The MCP250XX Development Kit supports two methods for programming the
user defaults.

1. Using the Device Programmer circuit with the programming software.

2. Node A has an ICSP connector.

4.3 Device Programmer

A device programmer circuit is built into the board to allow the user to easily
program MCP250XX devices with the existing board (i.e., PRO MATE is not
needed).

4.3.1 Circuit Description

The programming circuitry is designed to use the ICSP methodology as
defined in the MCP250XX Programming Specification (DS20072). The
circuitry routes all of the required signals, including the 13V Vpp signal that is
generated by a step-up voltage regulator. Figure 4.1 shows the pinout for the
MCP250XX socket in the Device Programmer circuitry.
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FIGURE 4.1: DEVICE PROGRAMMER DIAGRAM

MCP250XX
1~ aaf——
[]2 13 ]
[]3 12] ]
[]4 1]
R [ 10[]
—e 0[]
[]7 8]

To Host PC

Step-up Regulator

Circuit

4.3.2 PC Software

The programming circuitry is controlled by a host PC application through the
DB25 connector. The PC application is a graphical interface that allows the
device to be quickly and easily configured with the user defaults. Figure 4.2
shows the main screen, used to navigate to all of the MCP250XX device
peripherals that can be configured with the defaults.

The other screens, as shown in Figure 4.3 - Figure 4.7, are for configuring all
of the peripherals. Together, both the hardware and software use the ICSP
methodology as described in the MCP250XX programming specification.

The software has the ability to save user defaults into IHEX8 format, which
can be imported to the PRO MATE device programmer through MPLAB IDE
for programming the MCP250XX devices.
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FIGURE 4.2: PROGRAMMER SOFTWARE MAIN SCREEN

E}SMEPZSDH Programmer
Fosc =MW kHz D%1%
P T W MCP2E05x

File  Help

Scheduled T

| v

FIGURE 4.3: USER MEMORY

© 2002 Microchip Technology Inc. Preliminary DS51266B-page 27



MCP250XX USER’S GUIDE

FIGURE 4.4: CAN MODULE

TFFFFFF
TFFFFFF
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FIGURE 4.5: PWM MODULES
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FIGURE 4.6: A/D MODULE

ADC Registers

AJD Channel Enables

AN3 AN2 AN1 ANO

Time Between

Configures A/D the Conversion Rate Conversions
A¢0 Conversion AJD Aguisition Auto Conversion
Rate Time Time
[Fosc/2 =] [64/Tase =] 1:1 -
2 MHz 16 pz 0.256 ms
Cloze
GPDDR ADCOND ADCOMT IOINTEM I0IMTFO OPTREG1

L=

00||00||06||00HFO‘

ADCMPOH — ADCMPOL - ADCMPAH - ADCMPIL  ADCMP2H - ADCMPZL  ADCMPEH  ADCWPAL

Threshold Detection
- _\I_' - -

B

LEEY 4602Y 4111V 1918
AN3 ANZ AN1 ANOD

|62||40||D2||80||EFHCUHBE||00|

FIGURE 4.7: GPIO MODULE

GPIO Registers

GPOOR

GPLAT IDINTEM I0INTRO ADCONT  OPTREGT

L 1

80\|00||00||3F|\Do|

i Cancel
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4.4 Programming via the ICSP Connector

There is an ICSP connector on Node A that can be used to program the user
defaults with an external programmer. To insure successful programming, the
MCP250XX Programming Specification (DS20072) must be adhered to.

The JP4 jumper allows the MCP250XX socket to be isolated from board
power so the programmer does not have to drive the board while
programming.

FIGURE 4.8: PROGRAMMING VIA THE ICSP™ CONNECTOR

VDD
I Jcspm
|: JP4 onnector
MCP250XX T 5 |vep
N g 5 |voo
]2 13[] D | Vss
3 1207 I | DATA
s 17 — |CLOCK
— 5 10[]
6 9]
I —
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Chapter 5. Other Capabilities of the Development Board

5.1 Introduction

The MCP250XX Development Board has a few capabilities and
configurations that are discussed in this chapter.

5.2 Highlights

This chapter discusses:
+ Oscillator Configurations
* Node A Prototyping Area and Header Pinout
+ External CAN Bus Connections

5.3 Oscillator Configurations

The MCP250XX Development Board is configured, by default, to use a
common oscillator for all three CAN nodes. There are three oscillator sockets,
though only one is populated. The oscillator sockets are connected together
with their outputs. The two jumpers (JP1 and JP2) can be used to disconnect
the outputs and use individual oscillators for the nodes. The jumpers are
shorted by a trace on the bottom of the board by default. These traces can be
cut, and jumper pins can be installed, to control the oscillator output wiring.
See Figure 5.1 for details on the oscillator configurations.

FIGURE 5.1: OSCILLATOR SOCKET LAYOUT

Y1 Y2 Y3
Out Out Out
To PC Node To Node B To Node A
JP2 JP1
L Oo---0 o ---0o0—!

Shorted by trace on
bottom of board
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5.4 Node A Prototyping Area and He

ader Pinout

In addition to ICSP capabilities, Node A can also be used for prototyping

custom MCP250XX configurations. This node

has a prototyping area as well

as a header that can be used for probing the MCP250XX pinout. Figure 5.2

shows the layout of the header.

Note: JP4 must be shorted to enable bo
socket.

ard power to the MCP250XX

FIGURE 5.2: NODE A HEADER LAYOUT

Node A Header

ero—> X [X] <+—ap1
eP2 — X <—aP3
eps —I> ] [X] <——aPs
aPe —> ] [X] <—aP7

T™xcaN — [X] < RXcAN
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5.5 External

Bus Connections

The MCP250XX Development Board can be connected to an external CAN
bus through the DB9(s). The DB9 pinout is the same as the defacto standard,
as recommended by the CAN in Automation (CiA) group. At a minimum,
CANH (pin 7) and CANL (pin 2) must be connected. However, CAN_GND
(pin 3) and CAN_V+ (pin 9) may also be connected to supply power to and
from another board. Table 5.1 and Figure 5.3 show the pinout and connector,
respectively.

Note: If supplying power to or from the MCP250XX Development Board,
be sure the voltage regulator specification is not violated.

Table 5.1: CAN Connector Pinout

P;n Name Description
1 -- Reserved
2 CANL CAN low bus line
3 CAN_GND CAN ground
4 -- Reserved
5 N/C Not connected
6 N/C Not connected
7 CANH CAN high bus line
8 -- Reserved
9 CAN_V+ CAN power

FIGURE 5.3: EXTERNAL CAN BUS CONNECTOR
o
Qc\"’b Ny ec’é &
4 Q
& & & & ©
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NOTES:
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Appendix A. Schematics and Layouts

A.1 Introduction

This appendix contains the schematics and layouts for the MCP250XX
Development Kit.

A.2 Highlights

Diagrams included in this appendix:
* Vpp Step-Up Regulator circuit
* Programming Clock/Data Logic circuit
* PC Interface/CAN Node circuit
« CAN Bus Interface circuit
* Node A/Node B circuit

» Capacitors circuit
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A.3 Vpp Step-up Regulator

FIGURE A.1: VPP STEP-UP REGULATOR CIRCUIT

MCP250XX USER’S GUIDE
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A.4 Clock and Data for Programming

FIGURE A.2: PROGRAMMING CLOCK/DATA LOGIC CIRCUIT
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A.5 PC Node

PC INTERFACE/CAN NODE CIRCUIT

FIGURE A.3
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A.6 CAN Physical Layer

FIGURE A.4: CAN BUS INTERFACE CIRCUIT
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A.7 Node A and Node B

FIGURE A.5: NODE A/NODE B CIRCUIT
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A.8 Caps Page

FIGURE A.6: CAPACITORS CIRCUIT
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